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Limitations on Maintenance Services

The FactorSoft™ application is intended for use in accordance with the standards and processes described within this
documentation. Efforts to investigate and/or repair FactorSoft™ application or data integrity issues caused by activ-
ities or integrations outside of the intended use of the FactorSoft™ platform will be subject to the then-current Jack
Henry Professional Services billable hourly rate.

Standard Maintenance Services (Technical Support) does not include the following:

Investigation and Remediation of errors and data integrity issues caused, contributed to, or by any of
the following:

n a software program that was not originally provided by Jack Henry

l third-party automation, BOT/Screen Scraping technology, custom importers,
or any other integration with FactorSoft™ that was not created by or in con-
junction with Jack Henry.

n any modification not provided by Jack Henry to the software or standard database
schema

l the addition of custom database elements including triggers, stored pro-
cedures, tables, and columns

l the alteration of standard FactorSoft™ triggers, tables, columns, stored pro-
cedures and indexes

l the execution of T-SQL scripts resulting in changes to the data stored within
the FactorSoft™ database

n equipment, software, networks or any other infrastructure in the customer’s envir-
onment that does not meet the minimum requirements described within the then-
current FactorSoft™ product documentation

Please note that if you are exploring possibilities with third-party software providers or considering altering the FactorSoft database
in any way, it is strongly recommended that you discuss your plans with the FactorSoft™ support team before making any com-
mitments or changes. As your software partner, we may be able to help solve your business problem in a way that does not intro-
duce risk, data corruption, or system instability.
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Insurance Policy Center

The Insurance Policy Center add-on module is used to create new insurance policy records by entering
specific policy information. In addition, amounts allocated to individual debtors, claims against the policy,
important contacts, deductions, and so on can also be entered using this module. Once a policy is added,
this module can be used to modify policy details and review policy information.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

Insurance Policy Center User Guide
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Setting Up Insurance Policy Center

Before you can use Insurance Policy Center, some setup needs to occur. Some of the setup may have
been done when FactorSoft was implemented. If you have any questions, contact Technical Services.

The following outlines the setup steps that need to be done to set up Insurance Policy Center. More inform-
ation about each step can be found in the sections indicated. Once the setup is complete, you can create
insurance policies for clients and generate insurance related reports.

1. Turn on the Insurance Policy Center feature in the Control File

l Insurance Policy Center is one of our add-on modules for FactorSoft. Please contact Technical
Services to have Insurance Policy Center enabled for your business.

2. Set up Engine Task

3. Set up Tables

l "Defining Reason Codes" on page 8

l "Defining Red Flag Rules" on page 7

4. Set up System Preferences

5. Set up Security Roles

6. Create Client Terms. See the Administration Guide for more information.

7. Create Client.

l When you create the client you must select the Requires Insurance Policy check box on the
Insurance Policies panel of the Client Information screen.

8. Create Client/Debtor Relationship

l You must enter a value in the Max Credit Protection field on the Extra Terms tab.

9. Create Insurance Policy and work the policy as needed.

Setting Up Engine Tasks

You can set up an Engine Task to have the system automatically process Insurance Policy ineligibility
recalculations when changes occur in the data.

If you do not set up the engine task you will have to manually recalculate the data to see updates, see
"How to Recalculate Redundant Data" on page 53 for more information.
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You must also set a System Preference if you want allow the engine to process the task automatically any
time a transaction against a policy is processed. See "Setting System Preferences" on page 12 for more
information.

Contact our Technical Services team if you have any questions about setting up Engine Tasks.

CAUTION
We strongly recommend that the Engine services be stopped and restarted any time Insurance Policy
Center System Preferences are changed.

Insurance Policy Center User Guide
Insurance Policy Center
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1. Open up the EngineAdmin module.

2. In the Database Settings area, click Task Types.

3. Locate the Insurance Policy Ineligibles task in the list. Set the Default Priority to 9 and select the
Enabled check box.

4. In the Database Settings area on the left, click Task Server Load.

Insurance Policy Center User Guide
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5. Add the Insurance Policy Center task to the Queue:
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a. Click in the blank row near the top to add a new task to the queue.

b. From the Task Server Queue list, select the task service you want to process the task. This
task should be set up to execute within an exclusive Task Service, as the Task Service may
hang up if combined with Crystal Reports executions.

c. From the Task Type list, select Insurance Policy Ineligibles.

d. In Max Concurrent field, enter 1.

Insurance Policy Center User Guide
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e. Click Save Changes.

Defining Red Flag Rules

Red Flag Rules are used to define what appears in the Red Flag Queue and in the Red Flag Queue Report,
which are used to quickly see issues or critical warnings regarding your clients and accounts. There a few
Red Flag Rules you can set up for insurance policies in Insurance Policy Center.

To define Red Flag Rules, within FactorSoft Desktop, on the File menu, select Tables. Then, on the Client
& Debtor menu, select Red Flag Rules. Define the rules listed below as needed for Insurance Policy Center:

Insurance Policy Center User Guide
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l Insurance Policy Limit – Used to flag policies that have used a specific percentage of the policy
limit.

l Insurance Policy Expiration – Used to flag policies that are set to expire in a specific number of
days defined in the rule.

l Insurance Policy Premium Due – Used to flag policies that are within a specific number of days of
the premium due date.

l Insurance Turnover Declaration – Used to flag policies that are within a specific number of days
before the turnover date.

l Policy Expired Detail -Used to flag clients when the Insurance Policy has expired.

l Policy Limit Detail – Used to flag Clients that have used a specific dollar amount of the policy limit.

l Premium Payment Detail – Used to flag policies when the Insurance Policy Premium Payment is
due.

l Turnover Date Detail – Used to flag policies when the Insurance Turnover Declaration date is due.

For more detailed information about the Red Flag Rules table and screens, see the Red Flag Rules inform-
ation in the FactorSoft Admin Guide.

Defining Reason Codes

Before transactions can be processed for the client for insurance, reason codes must be set on the Dis-
pute/Ineligibility/No Buy Code Table screen in the Tables module and selected in System Preferences for
Ineligible Invoice Titles. The following codes must be defined exactly as pictured in the following image.

Note
When defining these codes, the In Dispute (Available for Recourse) check box and the To Flag
Invoices check box must be selected for each code.

Insurance Policy Center User Guide
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When defining codes on this screen, check boxes specific to the Insurance Policy Center module can be
used to designate which codes should be used for claims and which codes should be used for premiums.

To define a code as available on the Premium tab of the Insurance Policy Information screen, select the
For Insurance Policy Premium No Buy check box. To define a code as available on the Claims tab of the
Insurance Policy Information screen, select the For Insurance Policy Claim check box. For more

Insurance Policy Center User Guide
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information on the Premium tab, refer to "Premium Panel" on page 46. For more information on the Claims
tab, refer to "Claims Panel" on page 33.

The following table describes the reason each ineligibility rule is enforced. The rules are listed in order of
the priority in which an invoice can be affected.

Code Settings

No Insurance Alloc-
ation

This rule is enforced if allocation for the client/debtor rela-
tionship has not been defined in the Insurance Policy
Center module.

Policy Expired Ine-
ligibility

This rule is enforced if a purchase batch is entered for a
policy that has expired based on the entry at the policy
level in the Expiration Date field on the Invoice Policy
Information screen or based on the entry at the alloc-
ation level in the Limit Expiry Date field on the Allocation
tab.

Policy Premium Pay-
ment Overdue

This rule is enforced if a purchase batch is entered for a
policy for which the premium payment is past due based
on the entry in the Next Payment Due Date field on the
Premium panel of the Insurance Policy Information
screen.

Exceeds Client Credit
Limit

This rule is enforced if a purchase causes the client to
exceed the credit limit defined in the Total Client Credit
Limit field on the Credit/no buy panel of the Client Inform-
ation screen.

Exceed Finance Matur-
ity Date

This rule is enforced if any invoice associated with an
insurance policy exceeds the cutoff date of the policy. If
enforced, the policy becomes invalid and all future
invoices purchased for the policy are marked as
“Exceeds Finance Maturity Date”.

The overdue date is the Finance Maturity date plus the
overdue days.

The Finance Maturity date is calculated using the fol-
lowing formula:

(Tenor - Inv Age + Grace) + Purchase Date

Exceeds Insurer This rule is enforced if a purchase causes the client to

Insurance Policy Center User Guide
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Code Settings

Credit Limit exceed the credit limit for the insurer.

Max Invoice Ship
Period Exceeded

This rule is enforced if the number of days between the
invoice date and the transport date is greater than the
entry defined in the Max Inv Period field on the Extra
Terms tab on the Detail Aging screen.

Max Insurance Tenor
Ineligibility

This rule is enforced if the number of days between the
invoice purchase date and the invoice due date is
greater than the tenor setting defined in the Tenor
(Days) field on the Settings tab of the Insurance Policy
information screen.

Max Invoice Age
Exceeded

This rule is enforced if the number of days between the
invoice due date and the invoice begin date are greater
than the number of days defined in the Maximum
Invoice Age field on the Invoice Rules panel of the Client
Information screen or the term defined at the cli-
ent/debtor relationship level.

Max Invoice Term
Exceeded

This rule is enforced if the invoice has exceeded the
invoice term as defined in the Max Invoice Term field on
the Invoice Rules Panel of the Client Information screen or
on the Detail Aging screen on the Extra Terms tab.

Invoice Due Date is
Before Purchase Date

This rule is enforced if the due date entered for the
invoice is before the purchase date entered for the
invoice.

Exceeds Coverage
Availability

This rule is enforced if coverage for the client is not avail-
able at the policy level or the allocation level.

Note
If a purchase batch violates any of the insurance ineligible rules listed in the previous table, details
about the associated issue display in the Comment field on the Approve Purchase for Batch screen. If
an invoice fails due to violating more than one rule, the rule with the highest priority displays in the
Comment field.

In addition, each invoice that has violated an ineligible rule and the rule that was violated can be
viewed on the Inelibility report, accessed by clicking the Print button on the Collateral tab of the Client
Summary screen.

Insurance Policy Center User Guide
Insurance Policy Center

11 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



To resolve the issue, the batch can be reworked or deleted, errors should be fixed, and the batch can
be repurchased.

Setting System Preferences

System Preferences control various options and aspects of the Insurance Policy Center features and must
be set up before Insurance Policy Center can be used.

To access System Preferences, in the Admin module, on the System menu select System Preferences.
Then, set the options for the System Preferences listed in the table below depending on how you want the
Insurance Policy Center features to work.

Preference Description

Identification/System Constants > CLMS|Engine

Allow service to maintain insur-
ance policy ineligibility tables

Set this system preference to True
to have the system recalculate and
balance all amounts for the insur-
ance client each time a transaction
is processed. If this is set to True
you must also set up the Engine
Task for the recalculations to occur.
See "Setting Up Engine Tasks" on
page 2 for more information.

If this preference is set to False, use
the instructions in "How to Recal-
culate Redundant Data" on
page 53 to manually update the
insurance policy table data.

Data Entry Behavior > Purchase Entry > Field Edits/Actions

Show Transport Doc Date Set this system preference to True
or select the Show transport doc
date check box to enable the Trans-
port Doc field for data entry on the
Schedule Batch screen.

Client Terms Rules/Defaults > Defaults > Daily Rate & A/R Finance Terms

Administration fees taken from Set this system preference to

Insurance Policy Center User Guide
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Preference Description

Purchase to define when admin-
istration fees are taken.

The administration fee is cal-
culated using the following for-
mula:

(Invoice Amount x Adv
Rate) x Rate / Per x Fin-
ance Days

In this calculation, Finance Days =
Tenor (Detail Aging > Extra Terms
tab) - Invoice Age + Cushion (on
Detail Aging)

Administration fees base cal-
culation on

Set this system preference to Cash
Advance to define the basis for cal-
culating administration fees.

Fields/Screen Behavior > Miscellaneous

Use dispute codes instead of
explanation

Set this system preference to True
to use dispute codes (reason
codes) instead of manually enter-
ing explanations of failed invoices.

Client Rules/Defaults > Ineligibility/Summary Calculation > Ineligible
Invoice Titles

Exceeds Client Credit Limit

Exceeds Country Credit Limit

Exceeds Coverage Availability

Exceeds Finance Maturity Date

Exceeds Insurer Credit Limit

Invoice Due Date is Before
Purchase Date

Max Credit Protection Ineligibility

The preferences in this folder will
have a drop-down showing all dis-
pute codes that are marked as "in
dispute" aka ineligible. Choosing
one in the drop-down will link that
dispute code to the corresponding
ineligible rule regardless of the
naming convention.

If the System Preferences for a par-
ticular Ineligible Invoice Title is left
blank, the system will not enforce

Insurance Policy Center User Guide
Insurance Policy Center

13 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

Max Insurance Tenor Ineligibility

Max Invoice Age Exceeded

Max Invoice Ship Period Exceeded

Max Invoice Term Exceeded

No Insurance Allocation

Policy Expired Ineligibility

Policy Premium Payment Overdue

that rule.

System Preferences > Fields/Screen Behavior > Screens > Insurance
Policy Center

Allow Partially Covered Invoices Select the check box to allow
invoices to be partially covered.

Note: Only works for “Portfolio A/R
Finance Terms.”

Allow Max Liability to be greater
than Insurers Credit Limit

Select what you want to occur
when the max liability is greater
than the credit limit.

Use Max Credit Percentage in
Summary Calculations

Set to TRUE to use Max Credit Pro-
tection in Summary calculations
(Amount Used = Invoice Amount x
Max Credit Protection for all
invoices associated with the
policy).

Note: If the “Max Credit Protection” set
on the Detail Aging > NOA/Rules tab is
not zero, it will take priority over the
“Max Credit Protection” set on the Cli-
ent Information > Invoice Rules panel.

System Preferences > Client Terms Rules/Defaults > Defaults > Due Date
Fees

Due date fees are calculated on
the Advance Amount

Set to True to calculate fees on the
Advance Amount. If set to True, the

Insurance Policy Center User Guide
Insurance Policy Center

14 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

system uses the “Tenor” set on the
Extra Terms tab for the for the Cli-
ent/Debtor Relationship (the tab
only appears if enabled in System
Preferences).

Set to False to calculate the Due
Date on the Invoice Amount. If set
to False, the system uses the “Days
Due” set on the NOA/Rules tab on
the Client Again screen when cal-
culating due date fees.

Calculation:

l Inv Amount x Advance Rate x
(Rate + Plus) / Finance Days

l Finance Days = Tenor - Inv
Age + Cushion

l The system uses the
“Tenor” that is set on
the Extra Terms tab on
the Detail Aging screen
in this calculation. The
“Tenor” set on the Set-
tings panel on the Insur-
ance Policy Detail
screen is used when
applying ineligibility
rules.

Setting Up Security Roles

Security Roles are used to provide access to the Insurance Policy Center screens and features and must
be set up before Insurance Policy Center can be used.

To access Security Roles, in the Admin module, on the Security menu, select Manage Roles. Then, use the
information in the table below to help you determine how to set roles for your employees depending on
which tasks they will perform in Insurance Policy Center.

Insurance Policy Center User Guide
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Preference Description

The following security items are defined in the Reports, Insurance folder.

Print insurance policy
report

Set this security item to Yes to allow employees to print
the Insurance Policy report.

Print insurance
turnover report

Set this security item to Yes to allow employees to print
the Insurance Turnover report.

Print Insurance Excess
report

Set this security item to Yes to allow employees to print
the Insurance Excess report.

Print max credit pro-
tection report

Set this security item to Yes to allow employees to print
the Max Credit Protection report.

The following security items are defined in the Insurance module, Access folder.

Allows access to cre-
ate a new policy

Set this security item to Yes to allow employees to cre-
ate a new policy.

Allows access to edit
an existing policy

Set this security item to Yes to allow employees to edit
existing policies.

Allows access to view
a policy

Set this security item to Yes to allow employees to view
policy details for an existing policy.

Allows access to
delete a policy

Set this security item to Yes to allow employees to
delete a policy.

Allows access to add
a new claim.

Set this security item to Yes to allow employees to add
a new claim to a policy.

The following security items are defined in the Insurance module, Insurance
Panel - Allocation folder.

View Allocation Set this security item to Yes to allow employees to view
allocation details on the Allocation tab.

Update Allocation Set this security item to Yes to allow employees to
update allocation details on the Allocation tab.

Create Allocation Set this security item to Yes to allow employees to alloc-
ate new amounts to the policy on the Allocation tab.

Delete Allocation Set this security item to Yes to allow employees to
delete allocation amounts from the policy on the Alloc-

Insurance Policy Center User Guide
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Preference Description

ation tab.

The following security items are defined in the Insurance module, Insurance
Panel - Claims folder.

View claims Set this security item to Yes to allow employees to view
claim information for the policy on the Claims tab.

Update Claims Set this security item to Yes to allow employees to
modify existing claim information for the policy on the
Claims tab.

Create Claims Set this security item to Yes to allow employees to add
new claims to the policy on the Claims tab.

Delete Claims Set this security item to Yes to allow employees to
delete claims from the policy on the Claims tab.

The following security items are defined in the Insurance module, Insurance
Panel - Contacts folder.

View Contacts Set this security item to Yes to allow employees to view
contact information for the claim on the Contacts tab.

Update Contacts Set this security item to Yes to allow employees to
modify contact information for the claim on the
Contacts tab.

Create Contacts Set this security item to Yes to allow employees to add
contact information for the claim on the Contacts tab.

Delete Contacts Set this security item to Yes to allow employees to
delete contact information from the claim on the
Contacts tab.

The following security items are defined in the Insurance module, Insurance
Panel - Country folder.

View Country Set this security item to Yes to allow employees to view
country limits for the policy on the Country tab.

Update Country Set this security item to Yes to allow employees to
modify existing country limits for the policy on the Coun-
try tab.

Insurance Policy Center User Guide
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Preference Description

Create Country Set this security item to Yes to allow employees to add
new country limits for the policy on the Country tab.

Delete Country Set this security item to Yes to allow employees to
delete country limits from the policy on the Country tab.

The following security items are defined in the Insurance module, Insurance
Panel - Deductions folder.

View Deductions Set this security item to Yes to allow employees to view
deductible information for the policy on the Deductibles
tab.

Update Deductions Set this security item to Yes to allow employees to
modify deductible information for the policy on the
Deductibles tab.

The following security items are defined in the Insurance module, Insurance
Panel - Documents folder.

View Documents Set this security item to Yes to allow employees to view
documents associated with the policy on the Docu-
ments tab.

Update Documents Set this security item to Yes to allow employees to
modify documents associated with the policy on the
Documents tab.

Create Documents Set this security item to Yes to allow employees to asso-
ciate documents with the policy on the Documents tab.

Delete Documents Set this security item to Yes to allow employees to
delete documents associated with the policy on the
Documents tab.

The following security items are defined in the Insurance module, Insurance
Panel - Notes folder.

View Notes Set this security item to Yes to allow employees to view
notes about the policy on the Notes tab.

Create Notes Set this security item to Yes to allow employees to add
notes about the policy on the Notes tab.

Insurance Policy Center User Guide
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Preference Description

The following security items are defined in the Insurance module, Insurance
Panel - Premium Payment folder.

View Premium Pay-
ment

Set this security item to Yes to allow employees to view
premium details associated with the policy on the
Premium Payment tab.

Update Premium Pay-
ment

Set this security item to Yes to allow employees to
modify premium details associated with the policy on
the Premium Payment tab.

The following security items are defined in the Insurance module, Insurance
Panel - Settings folder.

View Settings Set this security item to Yes to allow employees to view
policy settings on the Settings tab.

Update Settings Set this security item to Yes to allow employees to
modify policy settings on the Settings tab.

The following security items are defined in the Insurance module, Insurance
Panel - Summary folder.

View Summary Set this security item to Yes to allow employees to view
the policy summary on the Summary tab.

The following security items are defined in the Client/Debtor Information, Extra
Terms folder.

View Extra Terms
Information

Set this security item to Yes to allow employees to view
the Extra Terms tab on the Debtor Aging screen.

Update Extra Terms Set this security item to Yes to allow employees to modi-
fy/update the fields on the Extra Terms tab on the
Debtor Aging screen.

Insurance Policy Center User Guide
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Using Insurance Policy Center Overview

The Insurance Policy Center module is used to create new insurance policy records by entering specific
policy information. In addition, amounts allocated to individual debtors, claims against the policy, import-
ant contacts, deductions, and so on can also be entered using this module. Once a policy is added, this
module can be used to modify policy details and review policy information.

TIP
To access Insurance Policy Center, on the FactorSoft Desktop, select Office > Insurance Policy Center.

The Insurance Policy Center screen is the entry point into the details of insurance policies for the Insur-
ance module. This screen displays each existing insurance policy as a line-item in the grid and provides
links to open the Insurance Information for the selected policy, add a new policy, create the Insurance
Policy Report and add a claim to the selected policy.

Auditing Changes

You can view a report of any changes, additions, deletions, and so on that have been made within the
Insurance Policy Center at any time by clicking the Audit button that appears on the bottom of the Insur-
ance Policy Center screens. For more information about viewing an audit report, see "Viewing and Printing
a Policy Audit Report" on page 56.
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The Policy Grid

The main area of the Insurance Policy Center screen shows a list of the policies that have been created.
To refresh the list of policies, click the Refresh button. The policy grid shows the following for existing
policies.

Field Description

Policy Name This column displays the name of the insurance policy.

Insurer This column displays the insurer assigned to the insur-
ance policy.

Insurers are defined on the Insurer table in the Tables
module.

Max Liability Amt This column displays the maximum liability amount for
the insurance policy.

Begin Date This column displays the effective start date for the insur-
ance policy.

Expiration Date This column displays the expiration date for the insur-
ance policy.

InActive This column displays a check mark if the policy is inact-
ive.

This column only appears if the “Show Inactive Policies”
check box is selected on the Filters tab.

Links Tab

The Links tab is used to create a new policy, add a claim for a policy, review information for an existing
policy, and request the Insurance Policy report. The following links are available on this tab:

Insurance Policy Center User Guide
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l Add a Claim. Select an existing policy and click the Add a Claim link to add a claim to the cor-
responding policy. The Claim Details window displays, where claim information can be entered. For
more information on the Claim Details window, refer to "Claim Details window" on page 34.

l Create New Policy. Click the Create New Policy link to access the Insurance Policy Information -
New Policy window, where details for a new policy can be entered.

l Policy Information. Select an existing policy and click the Policy Information link to review inform-
ation for the corresponding policy. The Insurance Policy Information window for the associated
policy displays, where policy information can be reviewed and modified.

l Report. Select an existing policy and click the Report link to request the Insurance Policy report for
the corresponding policy. For more information on this report, refer to .

Filters Tab

The Filters tab is used to filter the list of policies that displays on the Insurance Policy Center screen. Using
this tab, you can display only inactive policies, policies for all policy periods, and policies for a specific
insurer.

Use the following fields and check boxes to filter the list of policies on the Insurance Policy Center screen.

l Show Inactive Policies. Click the Show Inactive Policies check box to include inactive policies for
which the expiration date has passed. The “InActive” column will appear indicating which policies
are inactive.

l Show All Policy Periods. Click the Show All Policy Periods check box to display all policies, regard-
less of the expiration date.

l Selected Insurer. Select an insurer from the Selected Insurer list to display only policies for the cor-
responding insurer.

Once all filters have been entered, click the Apply Filters button to apply the filters and refresh the list of
policies. Simply clear the check boxes and click the Clear Insurer button to reset the filters and display the
default list of policies.

Creating a New Policy

The Insurance Policy Center screen is used to add a new insurance policy. Once a policy is added on this
screen, specific amounts can be allocated to individual debtors, claims and deductions can be assigned
to the policy, and so on.
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1. Open the Insurance Policy Center: In FactorSoft Desktop, on the Office menu, select Insurance
Policy Center. The Insurance Policy Center screen appears.

2. Click the Create New Policy link on the Links tab. The Insurance Policy Information - New Policy win-
dow appears.
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3. In the Policy Desc field, enter the name of the insurance policy.

4. In the Policy # field, enter the insurance policy number.

5. In the Max Liability field, enter the maximum liability amount for the insurance policy.

6. In the Begin Date field, enter the effective start date for the insurance policy. The current date is
automatically entered in this field, but can be changed. Click the down arrow in the field to select a
date from a calendar.

7. In the Expiration Date field, enter the expiration date for the insurance policy. The current date is
automatically entered in this field, but can be changed. Click the down arrow in the field to select a
date from a calendar.

8. From the Insurer list, select the insurer for the policy. These are the same insurers that are set up on
the Insurers table.

9. Select the Inactive check box if you want to set the policy as inactive.
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10. Click the Save button to save the policy.

11. The policy is created and the Insurance Policy Information screen refreshes to show a list of links on
the left where you can view and manage details for the policy.

12. You can now add claims, deductions, contacts, documents, and so on to the policy using the panels
listed on the left. See one of the sections listed below for more about what you can do on that panel.
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l Allocation

l Claims

l Contacts

l Country

l Deductions

l Documents

l Notes

l Premium

l Settings

l Summary

Allocation Panel

The Allocation panel is used to allocate specific amounts associated with the insurance policy to indi-
vidual debtors. When this panel is accessed, various allocation details previously associated with the
policy, such as the client name, debtor, allocation limit, and available limit, display.

TIP
To access the Allocation panel, click the Allocation link in the Navigation panel on the Insurance Policy
Information screen.
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To add allocation information for a debtor, click the New button. The Allocation Detail window displays. For
more information on this window, refer to "Allocation Detail window" on the next page .

Using this panel, allocation information for a debtor can also be reviewed, modified, and deleted. To
review or modify allocation information, highlight a line in the Allocation section and click the View button.
The Allocation Detail window displays, where information corresponding to the highlighted line can be
reviewed or modified. To delete allocation information, highlight the line to delete in the Allocation section
and click the Delete button. The corresponding line is deleted.

Note
Allocations can only be deleted if no purchase activity exists. For example, if an invoice has been pur-
chased and is associated with an allocation, the allocation cannot be deleted.

As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Insurance Policy Center User Guide
Insurance Policy Center

27 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Allocation Panel Field Descriptions

The following fields are available on the Allocation panel.

Field Description

Client Name This field displays the name of the client for which the
associated coverage limit is allocated.

Debtor This field displays the debtor for which the associated
coverage limit is allocated.

Coverage Limit This field displays the allocated coverage limit.

Coverage Available This field displays the allocated coverage limit available.

Priority This field displays the priority for the allocated coverage.

Limit Expiry Date This field displays the date the allocated coverage limit
expires.

Allocation panel Field Descriptions

Allocation Detail window

The Allocation Detail window is used to enter new allocation amounts or modify existing allocation
amounts for individual debtors. On this screen, allocation amounts can be entered or modified for a single
client-debtor relationship, or for multiple client-debtor relationships simultaneously.

Note
To enter new allocation amounts on the Allocation Detail window, a relationship between the client
and the debtor must be defined on the Debtor List window.
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The information displayed on this window is based on the method in which the window was accessed. If
this window is accessed by clicking the New button on the Allocation panel, click the Refresh Grid button
to view all new relationships awaiting allocations. If this window is accessed by highlighting an allocation
on the Allocations panel and clicking the View button, allocation information for the corresponding client-
debtor relationship displays.

TIP
To view all allocations, regardless of client or debtor, clear the Client Filter field, the Debtor Filter field,
and the Hide Existing Allocations check box, and then click the Refresh Grid button. All allocated
amounts display, regardless of client and debtor.

To define allocation amounts for a single client-debtor relationship, select only the check box associated
with the appropriate client-debtor relationship and enter allocation information, such as the coverage
limit, priority, country, and expiration date in the Apply to Selected section. Then select the Apply to Selec-
ted check box and click the Save button to apply the allocation amounts.

To define allocation amounts for multiple client-debtor relationships at the same time, select all check
boxes associated with the client-debtor relationships for which to allocation amounts and enter alloc-
ation information in the Apply to Selected section.
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TIP
Select the Hide Existing Allocations check box to hide all allocations previously defined, allowing you
to quickly identify and select only those allocations remaining to be defined.

After entering all necessary information, click the Apply to Selected check box and click the Save button.
The entered information is applied to all relationships selected.

In addition, allocation information can be modified by simply selecting a field to modify, such as the
Coverage Limit field, and entering a new amount. Once changes are made, click the Save button to save
the entries.

NOTE
All individual fields can be modified except for the Client Name field and the Debtor field.

Allocation Detail Window Field Descriptions

The following fields are available on the Allocation Detail window.

NOTE
The fields in the unlabeled Allocation section are the same as the fields in the Allocation sec-
tion on the Allocation panel. For more information on these fields, refer to "Allocation Panel
Field Descriptions" on page 28.

Field Description

Client Filter Enter the client for which to define allocation amounts.
Click the Down Arrow to display a list of valid entries.

Debtor Filter Enter the debtor for which to define allocation amounts.
Click the Down Arrow to display a list of valid entries.

Show Inactive Clients Select this check box to display allocation amounts for all
active and inactive clients.

Show All debtors for
All Clients

Select this check box to display allocations amounts for
all debtors, regardless of the client entered.

Hide Existing Alloc-
ations

Select this check box to hide all allocation amounts pre-
viously defined.

Apply to Selected Select this check box to apply all allocation information in
the Apply to Selected section to all client-debtor rela-

Allocation Detail window Field Descriptions
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Field Description

tionships selected in the Allocation section.

Coverage Limit Enter the allocated coverage limit.

Country Enter the country for the amount allocated to the debtor.
Click the Down Arrow to display a list of valid entries.

Expiry Date Enter the date the allocated coverage limit expires. Click
the Down Arrow to display the Calendar window, where
a date can be selected.

Priority Enter the priority for the allocated coverage. Click the
Down Arrow to display a list of valid entries.

Select All Rows in List Select this check box to automatically select all rows in
the Allocation section. Clear this check box to clear all
rows in the Allocation section.

Allocation Detail window Field Descriptions (continued)

How to Allocate Amounts to Debtors

The Allocation panel on the Insurance Policy Information screen is used to allocate specific amounts asso-
ciated with the insurance policy to individual debtors.

Note
To allocate amounts to individual debtors, a relationship between the client and the debtor must be
defined on the Debtor List window
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1. Access the Allocation panel.

TIP
To access the Allocation panel, click the Allocation link in the Navigation panel on the Insurance
Policy Information screen.

2. Click the New button.

The Allocation Detail window displays.

3. In the Client Filter field, enter the client associated with the debtor to which amounts should be
allocated.

Click the Down Arrow to display a list of valid entries.

4. Click the Refresh Grid button to display all debtors for the corresponding client for which amounts
have not been allocated.

5. (Optional) Clear the Hide Existing Allocations check box and click the Refresh Grid button to dis-
play all debtors, regardless of whether amounts have been allocated.

6. In the Allocations section, select the check box corresponding to the row amounts should be alloc-
ated.

TIP
If multiple check boxes are selected, allocation amounts are applied to all corresponding debt-
ors simultaneously.

7. In the Coverage Limit field, enter the coverage amount to allocated to the corresponding debtor.

8. In the Country field, enter the country for the allocated amount.

Click the Down Arrow to display a list of valid entries.

9. In the Expiry Date field, enter the date the allocated coverage expires.

Click the Down Arrow to display the Calendar window, where a date can be selected.

10. In the Priority field, enter the priority of the allocated coverage.

Click the Down Arrow to display a list of valid entries.

11. To set other details for the allocation (such as Tenor, Cushion (Grace Period), Finance Maturity Days,
and Overdue Days) see the Extra Terms tab of the Detail Aging screen.
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12. Select the Apply to Selected check box to apply the entered allocation amounts to all debtors selec-
ted in the Allocation section.

13. Click the Save button to apply the allocation amounts.

The allocation amounts are applied to all debtors selected in the Allocation section.

Claims Panel

The Claims panel is used to assign new claims to a policy and modify claims previously assigned to a
policy.

TIP
To access the Claims panel, click the Claims link in the Navigation panel on the Insurance Policy
Information screen.

When this panel is accessed, all claims assigned to the policy appear in a list/grid showing the following
for each claim:
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l Claim No – The claim number.

l Claim Date – This field displays the date the claim was assigned to the insurance policy.

l Amount – This field displays the claim amount.

l Status – This field displays the status of the claim.

To assign a new claim to the insurance policy, click the New button. The Claim Details window displays,
where a new claim can be assigned and invoices can be added to the claim. For more information on this
window, refer to "Claim Details window" below.

To modify details for an existing claim, highlight a claim in the Claims section and click the View button.
The Claim details window displays where claim details can be modified. To delete a claim, highlight a
claim in the Claims section and click the Delete button. Then click the Yes button to confirm the deletion
and delete the claim from the policy.

CAUTION
Claims can only be deleted if no purchase activity exists. For example, if an invoice has been pur-
chased and is associated with a claim or if a payment is associated with the claim, the claim cannot
be deleted.

In addition, if a claim exists against a payment batch, the payment batch or associated purchases
cannot be unprocessed.

As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Claim Details window

The Claim Details window is used to assign new claims to the insurance policy, modify details on existing
claims, and add invoices and payments to the claims.
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As information is added and modified on this window, a time stamp of the change and the User that mod-
ified the information is saved. Simply click the Audit button to access the Audit window, where a list of
changes can be reviewed. For more information on this window, refer to "Viewing and Printing a Policy
Audit Report" on page 56.

The following tabs are available on this window:

Invoices

The Invoices tab is used to associate invoices to the claim. When the Claim Details window is accessed,
this tab automatically displays and includes all invoices associated with the policy.

To associate invoices with a claim, simply select the check boxes for the corresponding invoices and click
the Save button. The invoices are associated with the claim and the amounts in the Total Invoices field
and the Unpaid Balance field are automatically updated.

Payments

The Payments tab is used to review all payments made for the claim. When the Payments tab is
accessed, payments made for invoices associated with the claim automatically display. Information such
as the posting date, payor, check number, and payment amount can be reviewed.

NOTE
This tab is only available after a new claim has been saved or when modifying an existing
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claim.

Notes

The Notes tab is used to enter notes about the claim. When this tab is accessed, notes previously added
to the claim, the date the note was added, and the user who added the note, can be reviewed.

To add a new note to the claim, click the Add New Note button. The Notes field is enabled, where a new
note can be added. After entering the note, click the Save Note button to save the note to the claim.

NOTE
This tab is only available after a new claim has been saved or when modifying an existing
claim.

Claim Details window Field Descriptions

The following fields are available on the Claim Details window.

Field Description

Policy Number This field displays the insurance policy number.

Claim Number Enter the claim number.

Reason Code Enter the reason code for the claim. Select the Use Claim
Number as Description Code check box to use the claim
number as the description code instead of entering a
reason code.

Reason codes are defined on the Dispute/Ineligibility/No
Buy Code table in the Tables module. For more inform-
ation on defining reason codes, refer to "Defining
Reason Codes" on page 8.

Claim Amount Enter the amount for the claim.

Claim Date Enter the date the claim was assigned. Click the Down
Arrow to display the Calendar window, where a date can
be selected.

Claim Status Enter the status of the claim. Click the Down Arrow to dis-
play a list of valid entries.

Claim Summary This section displays a summary of the claim, including

Claim Details window Field Descriptions
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Field Description

the following:

l Claim Amount. This field displays the total claim
amount.

l Total Invoices. This field displays the total amount
of all invoices associated with the claim.

l Total Payments. This field displays the total
amount of all payments received towards the
claim.

l Unpaid Balance. This field displays the balance
remaining for the claim.

The following fields display on the Invoices tab.

Client Filter Enter the client for which to view invoices for the claim.

Debtor Filter Enter the debtor for which to view invoices for the claim.

Show Inactive Clients Select this check box to view invoices for active and inact-
ive clients.

Show All Debtors for
All Clients

Select this check box to view invoices for all debtors.

Show All Invoices for
this Policy

Select this check box to view all invoices associated with
the insurance policy.

Client Name This field displays the client for the corresponding invoice.

Debtor This field displays the debtor for the corresponding
invoice.

Invoice No This field displays the invoice number.

Invoice Date This field displays the date for the corresponding invoice.

Invoice Amount This field displays the invoice amount.

Invoice Balance This field displays the balance for the corresponding
invoice.

Coverage Amount This field displays the coverage amount remaining for

Claim Details window Field Descriptions (continued)
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Field Description

the corresponding invoice.

The following fields display on the Notes tab.

Created Date This field displays the date and time the note was
entered.

Note This field displays the note.

Note Entered By This field displays the user who entered the note.

Notes Click the Add New Note button and enter a note in this
field. Once the note is entered, click the Save Note button
to save the note to the claim.

Claim Details window Field Descriptions (continued)

Adding a Claim

The Claims panel is used to add a new claim to a policy. When adding a claim, invoices and payments
can also be associated with the claim.

Note
If multiple policies exist, only invoices covered by the policy associated with the claim can be added
to the claim. Invoices covered by other policies only display when a claim is added for those policies.
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1. Access the Claims panel: click the Claims link in the Navigation panel on the Insurance Policy
Information screen.

2. Click the New button. The Claim Details window displays and all invoices not yet associated with a
claim display in the Select Invoices to Add to the Claim section.

3. In the Claim Number field, enter the claim number.

4. In the Reason Code field, enter the reason code for the claim or select the Use Claim Number as
Description Code check box to use the claim number as the description code instead of entering a
reason code.

5. In the Claim Amount field, enter the amount for the claim.

6. In the Claim Date field, enter the date the claim was assigned.

7. In the Claim Status field, select the status of the claim.

8. In the Select Invoices to Add to the Claim area, select the check box corresponding to all invoices
that should be associated with the claim.

9. Click the Save button to add the claim. The claim is added and claim information automatically dis-
plays in the Claim Summary section. Once the claim is added, invoices and payments can be
added to the claim on the Invoice tab and the Payments tab, respectively.

Contacts Panel

The Contacts panel is used to assign new contacts to the insurance policy and review all contacts pre-
viously assigned to the policy. Using this panel, you can review various information for all contacts
assigned, such as the name, phone number, and whether the contact is the guarantor for the associated
policy.

TIP
To access the Contacts panel, click the Contacts link in the Navigation panel on the Insurance Policy
Information screen.

When you view the Contacts panel, all contacts assigned to the policy appear in a grid list. To exclude
inactive contacts from the grid, click the Hide Inactive Contacts check box.
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As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Adding a New Contact

The Contact Information window is used to add a new contact to the insurance policy.

To add a new contact:
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1. On the Contacts panel, click the New button. The Contact Information screen appears.

2. Enter the basic information for the contact in the following fields:

l First Name – Enter the contact’s first name.

l Last Name – Enter the contact’s last name.

l Title – Enter the business title of the contact.

l Phone – Enter the contact's primary phone number.

l Fax – Enter the contact's fax phone number.

l Extension – Enter the contact's primary phone number extension.

l Email – Enter the contact’s email address.

3. In the Ownership (%) field, enter the percentage of ownership in the client business that the con-
tact has, if applicable.
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4. Select the Authority check box to indicate that the contact has authority within the client organ-
ization to make decisions about the policy such as the authority to sign off or verify invoices.

5. Select the Attention check box to include the contact’s fax or email address when sending notices,
reports, or statements.

6. Select the Guarantor check box to indicate that the contact is the guarantor for the facility.

7. In the Comments field, enter any additional information you want to save about the contact if
needed.

8. Use the Inactive check box to mark the contact as no longer an active contact for the client.

9. Click the (Save) button.

Modifying a Contact

l To modify details for an existing contact, select the contact in the grid list and click the View button.

The Contact Information window appears. Then, click the (Edit) button to enable the fields on

the Contact Information window and make changes. When you are done, click the (Save) but-
ton.

l To make the contact inactive for the client, select the Inactive check box.

Deleting a Contact

l To delete a contact, select the contact you want to delete from the list/grid and click the Delete but-
ton. Then click the Yes button to confirm the deletion and delete the contact from the list.

Country Panel

The Country panel is used to assign limits for one or more countries. If the combined credit limit of all debt-
ors associated with the insurance policy and the country is greater than the country limit for the policy, all
invoices added to the policy for the debtor or country are automatically flagged as ineligible at the time
of purchase.

TIP
To access the Country panel, click the Country link in the Navigation panel on the Insurance Policy
Information screen.
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As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Adding a Country Limit

1. From the Select a Country list, select the country for which you want to define a limit.

2. In the Country Limit field, enter the dollar limit to enforce for the country. When a purchase is
executed in FactorSoft, the credit limit for the debtors associated to this policy and country are
summed and compared to the country limit. If the debtor limit is in excess of the country limit, all of
the invoices for that debtor/country are ineligible at purchase.

3. Click the Add/Save Limit button. The country limit is saved and appears in the grid on the screen.
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Modifying or Deleting Country Limits

l To modify a country limit, select the limit in the Country grid, then change the entries in the Select a
Country field and the Country Limit field, and click the Add/Save Limit button. The country limit is
updated and the new information displays in the Country section.

l To delete a country limit, select the limit you want to delete in the Country grid and click the Delete
Limit button. Click the Yes button to confirm the deletion.

Deductibles Panel

The Deductibles panel is where you can add a loss amount and a non-qualifying loss amount for the
policy. These deductions are used for information only, they are not used in any calculations for the policy.

TIP
To access the Deductibles panel, click the Deductibles link in the Navigation panel on the Insurance
Policy Information screen.

As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.
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Adding or Changing Loss Amounts

l To add a loss amount or a non-qualifying loss amount, enter the amount in the First Loss field or
the Non-Qualifying Loss field, respectively. Then enter any additional information related to the
loss amount in the corresponding Note field (notes can be up to 500 alpha-numeric characters)
and click the Save button. The loss amounts are saved to the policy.

l To make changes to the loss amounts, change the amounts and notes as necessary and click the
Save button to save the changes.

Notes Panel

The Notes panel is used to view and enter notes about the insurance policy.

TIP
To access the Notes panel, click the Notes link in the Navigation panel on the Insurance Policy Inform-
ation screen.

As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
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button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Notes Panel Field Descriptions

Field Description

Post Date The date the note was added to the policy.

Note The text of the note.

Note Entered By The user who entered the note.

Adding a New Note

To add a new note, click the Add New Note button and enter up to 499 characters in the Note field. Click
the Save Note button to save the note. The note is saved and displays in the Notes section.

Premium Panel

The Premium panel is used to enter information related to policy such as the premium rate, minimum
amount due, next payment amount and due date, and so on can.

The amounts entered in the fields on the Premium panel are for memo purposes only and are not used in
any calculations.

TIP
To access the Premium panel, click the Premium link in the Navigation panel on the Insurance Policy
Information screen.
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As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Premium Panel Field Descriptions

Field Description

Rate Enter the premium rate as a percentage.

Min Policy Premium
Amt

Enter the minimum amount due for the policy premium.

Next Payment
Amount

Enter the payment amount due at the next due date.

Next Payment Due
Date

Select the date when the next payment amount is due.

No Buy Reason Select the no buy reason code for the insurance policy.

No Buy Reason codes are defined on the Dis-
pute/Inelgibility/No Buy Code table in the Tables module.

Insurance Policy Center User Guide
Insurance Policy Center

47 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Premium Paid When set to Yes the EDW export will include information
about whether the premium is paid by the client. By
default, any existing policies are set to False.

Settings Panel

The Settings panel is used to define various settings for the insurance policy, such as the tenor, currency
used, and the turnover declaration and date.

TIP
To access the Settingsssssssss panel, click the Settings link in the Navigation panel on the Insurance
Policy Information screen.

As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
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button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Settings Panel Field Descriptions

Field Description

Tenor (Days) Set the number of days until the policy expires. This field
is four digits in length, numeric only.

This is the Tenor that will be used to determine the
ineligible rule.

Currency Select the type of currency used for the insurance policy.

Currency codes are configured in the Currency Denom-
inations table of the Tables module.

Turnover Declaration Select the turnover differential frequency for the insur-
ance policy, such as monthly or annually.

Turnover Date Select the date on which next turnover declaration is anti-
cipated.

Summary Panel

The Summary panel shows information such as the policy such as the total policy amount, the amount
used, and the amount remaining.

TIP
To access the Summary panel, click the Summary link in the Navigation panel on the Insurance Policy
Information screen.
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As information is added and modified on the Insurance Policy Center module, a time stamp of the change
and the user that modified the information is saved and can be viewed on the Audit report. Click the Audit
button to access the Audit window, where a list of changes can be reviewed on the Audit report. For more
information on this window, refer to "Viewing and Printing a Policy Audit Report" on page 56.

Summary Panel Field Descriptions

Field Description

Policy Amount The total amount for the policy.

Amount Used The total amount of claims against the policy (the policy
amount currently used).

Amount Remaining The policy amount currently available.

Calculation: Policy Amount - Amount Used

Percent Used The percentage of the policy amount currently used.
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Field Description

Calculation: Amount Used / Policy Amount

Displays the percentage of the amount of claims from
the Amount Used divided by the total Policy Amount

Percent Remaining The percentage of the policy amount available.

Calculation: Policy Amount - Percent Used

How to Define Ineligibles and Pricing for a Client

Prior to using the Insurance Policy Center module, various information must be defined for a client to allow
insurance policy ineligibles and pricing to function properly.

1. Create a new policy for the client-debtor relationship. For more information on creating a new
policy, refer to "Creating a New Policy" on page 22.

2. Allocate amounts to debtors on the Allocation tab. For more information about allocating amounts
to debtors, refer to "How to Allocate Amounts to Debtors" on page 31.

3. Access the Client Info screen and on the Insurance Policies panel select the check box to enable
insurance policies for the client.

4. Add a new A/R finance portfolio based term or highlight an existing A/R finance portfolio based
term or invoice based term.

5. Make entries in the Administrative fee (%) field, the Basis plus field, and the Take at field to define
how fees are generated for insurance policies. This is for A/R finance portfolio terms.

Note
If fees are defined to be taken at purchase, the System Preference Client terms rules/defaults,
Defaults, Daily rate & A/R finance terms, Administrative fees taken from must be set to
Purchase and the System Preference Client terms rules/defaults, Defaults, Daily rate & A/R
finance terms, Administration fees base calculation on must be set to Cash Advance.

Advanced Topics

Overriding Advanced Rate at Client-Debtor Relationship

The Debtor Aging screen can be used to override the advanced rate for specific debtors associated with
the client. To define a new advance rate for a debtor, the reserve escrow rate must be adjusted on the
Debtor Aging screen.
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For example, to calculate an advance rate of 85%, enter 15 in the Reserve Escrow Rate (%) field. The
reserve escrow rate of 15% is subtracted from 100% to calculate an advance rate of 85%.
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How to Recalculate Redundant Data

The Recalculate Redundant Data screen can be used to recalculate redundant data for the Insurance
Policy Center module.

You only need to perform these steps if you have not set up the system to automatically recalculate data.
See "Setting System Preferences" on page 12 for more about how to have the system automatically main-
tain the insurance policy data.
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1. Access the Recalculate Redundant Data screen.

TIP
To access the Recalculate Redundant Data screen, select System → Database Maintenance →
Recalculate Redundant Data in the Administration module.

2. In the Client field, enter the client for which to recalculate redundant data for the insurance policy.

3. Click the Insurance Policies button.

The Form window displays.

4. In the unlabeled Insurance Policy field, enter the insurance policy.

5. Click the Recalc button to recalculate redundant data for the policy.

The data is recalculated and the window closes.
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Client Information – Insurance Policy Panel

The “Insurance Policies” panel on the Client Information screen gives the User the ability to enforce insur-
ance policy rules for a client and see which insurance policies are associated with the client. Use the
Requires Insurance Coverage check box to enable insurance rules for the client. Once enabled, the Policy
Name, Policy Number, and Limit for any policy associated with the client will appear on the panel.

Field Description

Requires Insurance
Coverage

Select to enable insurance rules for the client.

Grid

Policy Name Displays the Policy Names associated with the client.

Policy # Displays the Policy Number associated with the client.

Policy Limit Displays the Policy Limit associated with the client.
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Viewing and Printing a Policy Audit Report

The Audit Window is used to review the Audit report, which lists the specific data added when a new policy
was created, the changes made to existing policies, and the user who added or modified the information.
Using the information on this screen, you can easily hold appropriate personnel accountable for any incor-
rect or unauthorized policy updates.

As policies are added and modified, a time stamp of the change and the user that modified the inform-
ation is saved. Using this window, you can view the date the change was made, the window or tab where
the change was made, the user who made the change, the field that was changed, the entry before and
after the change was made, and so on.

To help you locate changes for a specific window, field, user, and so on, various sort and filter options are
available by right-clicking the column heading. Using these options can help you determine whether
entries made on a specific window or by a specific employee are valid.

To print the displayed audit information, simply click the Print button. The Preview window displays, where
the Audit report can be formatted, printed, exported, saved, and so on.

Audit Window Field Descriptions

The following fields are available on the Audit window.
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Field Description

Date This field displays the date and time the change was
made.

Form This field displays the screen, window, or tab on which the
change was made.

User This field displays the user who made the change.

Field This field displays the field in which the change was
made.

Before This field displays the entry in the field before the change
was made.

After This field displays the entry in the field after the change
was made.

Action This field displays the type of change made, such as
Added, Changed, or Deleted.

Audit window Field Descriptions

Preview Window

The Preview window displays a preview of the Audit report or other information generated when clicking
the Print button on various screens and tabs in the Insurance Policy Center module. Numerous tools are
available on this window to allow you to customize the report based on personal preference before the
report is printed.
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Preview Window Field Descriptions

The following buttons are available on the Preview window toolbar.

Button Description

(Search) Click the (Search) button to access the Find window,
where a search for full or partial words within the report
can be performed.

(Customize) Click the (Customize) button to access the Print
Options window, where various options can be used to
format the report.

(Open) Click the (Open) button to access the Open window,
where a different report can be selected and displayed
on the Preview window.

(Save) Click the (Save) button to access the Save As window,
where the report can be saved to a specific location.

(Print) Click the (Print) button to access the Print window,
where print settings can be defined and the report can

Preview window Button Descriptions
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Button Description

be printed.

(Quick Print) Click the (Quick Print) button to print the report at the
designated printer.

(Page Setup) Click the (Page Setup) button to access the Page
Setup window, where advanced print settings, such as
paper size, printer tray, orientation, and margins can be
defined.

(Header and
Footer)

Click the (Header and Footer) button to access the
Header and Footer window, where the format for the
report header and footer can be defined.

(Scale) Click the (Scale) button to access the Scaling window
where the size of the report in a percentage or in a spe-
cific number of pages can be defined.

(Hand Tool) Click the (Hand Tool) button to enable the Hand tool,
allowing you to drag the report image within the Preview
window if the report is larger than the window.

(Magnifier) Click the (Magnifier) button to enable the Magnifier
tool, allowing you to zoom in and zoom out with each
click of the mouse.

(Zoom Out) Click the (Zoom Out) button to reduce the viewing
scale by five percent with each click.

(Zoom In) Click the (Zoom In) button to increase the viewing
scale by five percent with each click.

(First Page) Click the (First Page) button to display the first page
of the report.

(Previous Page) Click the (Previous Page) button to display to the pre-
vious page of the report.

(Next Page) Click the (Next Page) button to display the next page
of the report.

Preview window Button Descriptions (continued)
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Button Description

(Last Page) Click the (Last Page) button to display the last page of
the report.

(Multiple Pages) Click the (Multiple Pages) button to access the Mul-
tiple Pages window, where the the number of pages to
display on the Preview window can be selected.

(Background
Color)

Click the (Background Color) button to access the
Color window, where a background color for the report
can be selected.

(Watermark) Click the (Watermark) button to access the Water-
mark window, where a graphic or text can be defined to
use as a watermark for the report.

(Export Docu-
ment)

Click the (Export Document) button to access the PDF
Export Options window, where export settings can be
defined and the report can be exported. Click the Down
Arrow button to specify the file type for which to send the
report.

Once settings are defined, click the OK button. The Save
As window displays, where a location to save the report
can be selected and the report can be saved.

(Send via Email) Click the (Send via Email) button to access the PDF
Export Options window, where export settings can be
defined and the report can be attached to an Email mes-
sage. Click the Down Arrow button to specify the file
type for which to send the report.

Once settings are defined, click the OK button. The Save
As window displays, where a location to save the report
can be selected and the report can be saved. After the
report is saved, an Email message corresponding to the
default Email application is created and the report is
automatically attached.

(Exit) Click the (Exit) button to close the Preview window.

Preview window Button Descriptions (continued)
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Generating Reports Overview

There are several reports you can run to view information associated with the Insurance Policy Center
module, such as coverage amounts remaining, memos applied during payment, dispute codes posted
against payments, and so on.

See the following sections for more information about running one of these reports:

l "Credit Memo Report" on page 81

l "Dispute Report" on page 77

l "Excess/Dispute Report " below

Excess/Dispute Report

The Excess/Dispute Report lists all invoices that have been disputed and are not covered by the insurance
policy.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

This report is accessed from the Dispute/Ineligibility menu of the Reports module, provided the user has
security rights enabled.

The default report definition for this report is DisputeInvIns1.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
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Field Description

print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Insurance
Policy

Select the insurance policy to which to limit the report results from the list.

Report Select the report type to request.

l All Invoices Placed in Dispute.: This report displays all invoices that include a dispute
code.

l Open Invoices Placed in Dispute.: This report displays all invoices that include a dis-
pute code and the invoice balance is not zero.
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Report Sample

The date in the Re-Purchase Date field on this report corresponds to the date entered
in the Repurchase field for data purposes only on the Invoice Information screen.

Insurance Policy Report

The Insurance Policy report lists policy details, such as the percentage of the policy used, the percentage
of the policy remaining, the coverage amount used, the coverage amount remaining, the invoices for spe-
cific debtors, and so on, for the specified client.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

This report is accessed from the Analysis menu of the Reports module, provided the user has security
rights enabled.

The default report definition for this report is InsPolicy.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Insurer Insurer's Name

This drop-down is set up in Tables > Client & Debtor > Insurers

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Insurance
Policy

Select the insurance policy to which to limit the report results from the list.

Show Select the status of the insurance policies you want the report to contain:
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Field Description

l Current – Shows all active current policies.

l Outstanding – Shows policies that have open invoices allocated to them (active and
expired).

l Expired – Shows all expired policies.

l All – Shows all policies (current and expired).

Report Sample

Column Description

Insurer Insurer's Name

Policy Desc Policy’s Description

Client Name Client Name

Policy # Policy’s Number

Tenor A. Policy Level - Policy Information > Settings
Panel > Tenor

B. Client/Debtor Relationship Level - Detail
Aging > Extra Terms Tab > Tenor

% Used A. Insurer’s Level - Percentage of the Insurer's
Credit Limit that is used.

B. Policy Level - Percentage of the Policy Max
Liability limit that is used.
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Column Description

% Remaining A. Percentage still available under the Insurer’s
Credit Limit.

B. Percentage still available under the Policy
Max Liability limit.

Limit A. Insurer Level - Insurer’s Credit Limit.

B. Policy Level - Policy Information > Policy
Max Liability Limit.

C. Client/Debtor Relationship - Policy Inform-
ation > Allocation Panel > Coverage Limit for
the relationship

Invoice Balance Balance of the invoice that is covered by insur-
ance policy.

Coverage Used Amount for the invoice that used coverage
under the policy.

Expiration Date Date the Policy expires

Max Credit % Max Credit Protection % for the Client/Debtor
Relationship. Set at Detail Aging > NOA/Rules
Tab > Max Credit Protection

Availability Policy amount that is still available at the
Insurer’s Level, the Policy Level and the Cli-
ent/Debtor Relationship level.

Insurance Turnover Report

The Insurance Turnover report lists the number of invoices purchased against the insurance policy. This
report can be requested for paid and unpaid invoices.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

This report is accessed from the Analysis menu of the Reports module, provided the user has security
rights enabled.

The default report definition for this report is InsTurnover.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
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Field Description

are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Invoice
Type

Select whether to request the report for paid or unpaid invoices.

Policy
Name

Select the insurance policy for which to limit the report results from the list. Leave this field
blank to request the report for all insurance policies for the client.

Enter the insurance policy for which to limit the report results. Click the Down Arrow to display
a list of valid entries.

Leave this field blank to request the report for all insurance policies for the client.

Format Select whether to review the report in a detail format, which displays a breakdown of invoices
for each policy, or summary format, which displays only the total number of paid and unpaid
invoices.

Report Sample

Detail Format:
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Summary Format:
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Column Description

Detail Format

Policy Name Policy Description

Invoice Number Invoice Number

Policy Number Policy #

Invoice Date Invoice Date

Invoice Amount Invoice Amount

Number of Unpaid Invoices Number of Unpaid Invoices associated with the policy

Number of Paid Invoices Number of Paid Invoices associated with the policy

Client Client Name

Debtor Debtor Name

Summary Format

Policy Name Policy Description

Policy Number Policy #

Number of Unpaid Invoices Number of Unpaid Invoices associated with the policy

Insurance Policy Center User Guide
Viewing and Printing a Policy Audit Report

73 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Number of Paid Invoices Number of Paid Invoices associated with the policy

Security Roles

To generate the Insurance Turnover Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Insurance Turnover Report

Max Credit Protection Report

The Max Credit Protection report is used to review the total amount of an invoice that exceeds the max-
imum credit protection, as defined for the client on the Client Information screen. Using this report, you
can review the over-funded amounts for a client after a specified grace period has expired.

The default report definition for this report is MaxCredProtect.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.
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Report Sample

NOTE
Data only displays on this report if the funded amount for the invoice exceeded the maximum credit
amount for the invoice and the invoice date plus the number of days until due (grace period + invoice
due date) is greater than the system working date.

Report Details

Column Description

Client Displays the Client’s name

Debtor Displays the Debtor's name.
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Column Description

Invoice # Displays the Invoice Number.

Invoice Amount Displays the Invoice Amount.

Invoice Balance Displays the Outstanding balance on the Invoice.

Finance Maturity Date Displays the Finance Maturity Date on the Invoice.

Grace Days Number of days for Grace (Cushion). This is set at Client Terms > Due Date Fee
Panel > Cushion or if using overrides, this is set at Detail Aging > Extra Terms
Tab > Overrides section > Cushion

Finance Maturity Days Displays the Number of days past the Finance Maturity date to the date of the
report.

Max Credit % Max Credit Protection %. This is set at Client Information > Invoice Rules Panel >
Max Credit Protection or if using overrides, this is set at Detail Aging >
NOA/Rules Tab > Max Credit Protection

Overage Amount Overage Amount = Funded Amount - Max Credit % Amount

Dispute Report

The Dispute report lists dispute codes posted against invoices on the Purchase window, as well as dispute
codes posted against payments and adjustments on the Post Payment window or the Adjustment screen.

The default report definition for this report is DisputeInv1.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Report Select the report type to generate:

l All invoices placed in dispute: to generate a report of all dispute codes that were pos-
ted against all purchased invoices on the Purchase screen.

l Open invoices placed in dispute: to generate a report of all dispute codes that were
posted against open invoices only on the Purchase screen.

l Codes posted against payments/adjustments: generates a report of all dispute
codes that were posted against payments and adjustments on the Post Payment
screen or Adjustment screen.

Include
Summary

Select this check box to include the total number of dispute postings under each client list-
ing when generating the report.

Report Sample

Report Details

Column Description

Client Displays the name of the Client associated to the Disputed Invoice.

Debtor/Customer Displays the name of the Debtor/Customer associated to the Disputed Invoice.

Invoice # Displays the Invoice Number of the Disputed Invoice.

PO # Displays the Purchase Order number associated to the Disputed Invoice.

Purchase Date Displays the Purchase Date of the Invoice.
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Column Description

Invoice Date Displays the Date of the Invoice.

Due Date Displays the Due Date of the Invoice as calculated by: Invoice Date + Days Due
= Due Date

Current Balance Displays the current balance of the Disputed Invoice.

Dispute Date Displays the Date the Invoice was Disputed.

Date Canceled Displays the Date the Dispute was canceled.

Dispute Reason Displays the Dispute Reason Code selected at dispute.

Notes Highlighted green, this row displays notes associated to the Disputed Invoice.

Security Roles

To generate the Dispute Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Dispute/Ineligibility Reports > Print Dispute Reports

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Fields/Screen Behavior, Miscellaneous folder.

Preference Description

Use dispute code
instead of explan-
ation

l If FALSE and Invoice Information > In Dispute is Checked, then the
Invoice is “In Dispute” and should appear on the Report.

l If TRUE and the Invoice Information > Explanation is populated with a
Dispute Code with “ In Dispute” Checked in Tables > Data Entry > Dis-
pute/Ineligibility/No Buy Code Table, then Invoice is “In Dispute” and
should appear on the Report.

Credit Memo Report

The Credit Memo Report lists credit memos applied at the time of payment. This report includes negative
payments for invoices on which a dispute code is set that is used To flag payments in the Dis-
pute/Ineligibility/No Buy Code Table..

This report is accessed from the Transactions menu of the Reports module.

The default report definition for this report is CreditMemo.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
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Field Description

business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
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Field Description

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Debtor Enter the debtor for which to request the report. Click the Down Arrow to display a list of valid
entries.

Leave this field blank to include all debtors in the report results.

To delete an entry in this field, click the Down Arrow twice to highlight the entry and press the
Delete key.

Debtor
Group

Enter the debtor group to which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Report Sample

Red Flag Rule Report

The Red Flag Rule report lists clients flagged for red flag conditions as of the current FactorSoft processing
date. Report: Rule Name Report, you can review various issues and critical warnings associated with any
of the Red Flag Rules setup in the Red Flag Rules Table. Report: Rule Type Report provides information
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associated with the Red Flag Rules associated the insurance policy for specific clients, such as policies
close to expiration, policies with chargebacks that exceed a specified percentage of the accounts receiv-
able (A/R) balance, and so on.

The default report definition for this report is RedFlag.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.
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Field Description

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Rule
Name

Select the rule type to which to limit the report results.

Red flag rules are defined on the Red Flag Rules table in the Tables module. For more inform-
ation on the rules that can be defined in the Tables module, refer to the FactorSoft Admin-
istrator’s Guide.
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Field Description

Rule
Type

Select the rule type to which to limit the report results.

Red flag rules are defined on the Red Flag Rules table in the Tables module. For more inform-
ation on the rules that can be defined in the Tables module, refer to the FactorSoft Admin-
istrator’s Guide.

Report Sample

Rule Type Report

Rule Name Report
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Report Details

Column Description

Rule Name Report

Client Client Name

Rule Name Rule Name as established in Red Flag Rules Table

Rule Type Rule Type as established in Red Flag Rules Table

A/R Balance Client’s A/R Balance

Level Level as established in the Red Flag Rules Table
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Column Description

Group Filter Value as established in Red Flag Rules Table

Posted Date the Red Flag was effective

Rule Type Report

Client Name Client Name

Policy Name Policy Description

Policy Number Policy Number

Policy Limit Policy’s Max Liability

Coverage Amount Amount covered by the Policy

Percentage Used Percentage of the Policy that has been used

Security Roles

To generate the Red Flag Rule Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Red Flag Rule Reports
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